ODDS WIZARD

Version 2.90

User Guide

©1999-2022 Newhaven Software Ltd
Table of Contents

1 General overview 3

2 User interface 4
  2.1 Main form 4
  2.2 Table of standings 6
  2.3 Charts of ratings 7

3 User's tasks 8
  3.1 Input of league data 8
  3.2 Computing, viewing, printing, and exporting odds 9
  3.3 Feeding odds to Stake Wizard 12
  3.4 Updating leagues via Internet 12
  3.5 Live results and odds 13
  3.6 Updating league data from text files 13
  3.7 Renaming many teams 14
  3.8 If you are a bookie 14

4 Options 14
  4.1 Current league options 15
  4.2 Groups and rules of ranking 17
  4.3 Internet options 19
  4.4 Stake Wizard options 20
  4.5 Miscellaneous options 22

5 Tools 22
  5.1 Odds converter 22
  5.2 Stake Wizard 4 25
  5.3 Tournament analysis 25
  5.4 Data retriever 28
  5.5 Games filter 29
  5.6 Performance analysis 30
  5.7 Rename utility 32
  5.8 3D balls space 33

© 1999-2022 Newhaven Software Ltd
6 Stake Wizard Guide 34
   6.1 Overview and basic concept 34
   6.2 User interface 34
   6.3 Data input 36
   6.4 Running computations 37
   6.5 Results of computations 37
   6.6 Betting reports 38
   6.7 Mathematical background 40
7 What's new in version 2.90 "Live Magic" 43
8 Program registration 46
9 Installation notes 47
10 Acknowledgements 47
Index 49
1 General overview

Odds Wizard generates performance-based odds in any league sports, such as soccer, hockey, baseball, American football, rugby, basketball. Provides live results and corresponding live odds. Maintains over 120 Internet-updateable databases with the past games for the most of European soccer and hockey leagues, UEFA and International superleagues, NHL, MLB, NBA, NFL, ATP, and WTA. Keeps track of teams’ ratings in dynamics. Performs tournament analysis by computing odds for any team to occupy any place upon completion of scheduled games. Has built-in sophisticated bet optimizer Stake Wizard as a powerful tool. The program has convenient intuitive user interface.

The history of Odds Wizard goes back to 1998 when enchanting spectacle of World Cup in France had inspired development of prediction algorithms. First simple algorithm was implemented within the Excel worksheet as Visual Basic application. Since then, a lot of research efforts have been made towards enhancement of prediction strength. Initially, soccer was the only sport supported by Odds Wizard. Nowadays, other types of sports such as ice hockey, basketball, american football, baseball, and tennis are supported as well.

Odds Wizard computes fixed odds (1 X 2), money line or draw-no-bet odds (1 2), double-chance odds (1X 12 2X), Asian handicap odds, European handicap odds, scored goals, correct scores, half/full time odds (as many as over 100 various odds per event are computed). Three separate sets of odds for the match periods (full time, first time and second time) are supported, thus tripling the total number of computed odds. Odds Wizard can handle unlimited number of leagues with up to 1024 teams or players, and unlimited number of games per league. All supported leagues can be easily updated via the Internet connection.

Support of tennis sport is one of the new features of Odds Wizard. Underlying state-of-the-art algorithms are worth of the best previous developments and research efforts in soccer, hockey, and other sports. These algorithms are able to track live results and compute full set of in-play odds until the end of match.

In addition to the listed above features, Odds Wizard is able to display live results and all corresponding odds in a real time thus creating new dimension to the widest odds array.

As a matter of fact, Odds Wizard has been a virtual independent bookmaker providing any kind of odds on the basis of advanced statistical analysis and forecast. Unlike the real bookie, it doesn't make costly mistakes. Furthermore, it reveals such mistakes and enables bettor to rely not only on the good luck, but also on the probabilistic laws. Normally, the latter are on the side of a bookmaker as long as one releases correct line odds (prices). In such a case 10-20% of gross amount of stakes make up bookie's profit in the long run. Should the bookie's line odds exceed fair odds, bettor acquires reliable preconditions to win, and bookie to lose.

Odds Wizard may be used in three ways:

1) Set profit margin to 0%, generate fair odds, compare them to the bookie's lines, find occasions when the market odds are greater than fair odds, and place reliable stakes according to scientific approach provided by powerful tool Stake Wizard;

2) Set profit margin to 5-15%, generate market odds, and open new bookmaker office without bookie himself! Serious bookmakers may correct average market odds in a direction shown by the program.

3) Use Odds Wizard as an advisor.

Despite of seeming simplicity of the user interface, Odds Wizard performs very complex computations, which makes this program unique in the class of prediction software. The underlying algorithm is a result of extensive scientific studies.
2 User interface

2.1 Main form

Almost all of the Odds Wizard functions are accessible from the main form that also displays both input and output data. Main form is divided by the horizontal splitter, and consists of the following elements:

- **Menu and tool bar**

  Use either menu items or tool bar buttons to open and save league files, display and print odds, edit teams and games, get fixtures and updates via Internet, show standings, change options, show graphs, start computations, undo changes, activate tools, display help, and register this program.

- **Teams table**

  Stores teams along with their ratings, in-totals (i.e. contributions to the total scored goals), attack and defence variables, places, and points. Sorting teams can be accomplished by clicking headers of appropriate columns.

- **Games table**

  Stores past games and fixtures along with their attributes.

- **Odds table**

  Odds table holds as many as 107 various odds per each event, including fixed odds, money line (draw-no-bet), Asian or European handicap odds, scored goals, correct scores, under / over goals, half/full time odds. Three odds sets for each match period (in soccer) can be selected using menu item `Odds ® Match period`. Odds table displays live odds when the live odds mode is turned on. It is splitted into 6 views:

  **General view**

  ![General view](image)

  **Correct scores**

  ![Correct scores](image)
### Asian handicaps

| N  | Home team          | Away team          | 0.0 | 1.1 | 2.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 0.3 | 0.4 | 0.5 | 0.6 | 0.7 | 0.8 | 0.9 | 1.0 | 1.1 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 | 0.0 | 0.1 | 0.2 | 1.0 | 2.0 |
|----|--------------------|--------------------|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|_____
3. **Red** on the *Correct scores* view indicates the probability of some certain score to happen. The greater the probability, the deeper the red color.

4. Gray - same as 2 but with unfavorable upward market odds trend. Shades of gray color meet those of green color by their intensity. Press the shortcut `<Ctrl-M>` or use menu item Odds → Antibet filters → **Upward market trends** to turn on/off this option.

1 and 4 are the elements of Odds > Antibet filters. 2 and 4 appear when user chooses Odds > Market line odds.

- **Live score table**

<table>
<thead>
<tr>
<th>N</th>
<th>Home team</th>
<th>Away team</th>
<th>Kickoff</th>
<th>Status</th>
<th>Min</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Stoke City FC</td>
<td>Liverpool FC</td>
<td>24:05:17</td>
<td>1st half</td>
<td>43</td>
<td>5:0</td>
</tr>
<tr>
<td>2</td>
<td>Newcastle United FC</td>
<td>West Ham United FC</td>
<td>24:05:17</td>
<td>Half time</td>
<td>45</td>
<td>0:0</td>
</tr>
<tr>
<td>3</td>
<td>Manchester City FC</td>
<td>Southampton FC</td>
<td>24:05:17</td>
<td>1st half</td>
<td>43</td>
<td>1:0</td>
</tr>
<tr>
<td>4</td>
<td>Leicester City FC</td>
<td>Queens Park Rangers</td>
<td>24:05:17</td>
<td>1st half</td>
<td>42</td>
<td>2:0</td>
</tr>
<tr>
<td>5</td>
<td>Hull City AFC</td>
<td>Manchester United</td>
<td>24:05:17</td>
<td>1st half</td>
<td>43</td>
<td>0:0</td>
</tr>
<tr>
<td>6</td>
<td>Everton FC</td>
<td>Tottenham Hotspur</td>
<td>24:05:17</td>
<td>Half time</td>
<td>45</td>
<td>0:1</td>
</tr>
<tr>
<td>7</td>
<td>Crystal Palace FC</td>
<td>Swansea City AFC</td>
<td>24:05:17</td>
<td>1st half</td>
<td>43</td>
<td>0:0</td>
</tr>
<tr>
<td>8</td>
<td>Chelsea FC</td>
<td>Sunderland AFC</td>
<td>24:05:17</td>
<td>1st half</td>
<td>42</td>
<td>1:1</td>
</tr>
<tr>
<td>9</td>
<td>Aston Villa FC</td>
<td>Birmingham FC</td>
<td>24:05:17</td>
<td>1st half</td>
<td>42</td>
<td>0:1</td>
</tr>
<tr>
<td>10</td>
<td>Arsenal FC</td>
<td>West Bromwich Albion</td>
<td>24:05:17</td>
<td>Half time</td>
<td>45</td>
<td>4:0</td>
</tr>
</tbody>
</table>

Live score table contains kickoff date and time, status of the game, minutes played, and the current score. It is refreshed every 5 seconds. To initiate display of live results and corresponding live odds, connect to the Internet, and click a button on a tool bar.

Depending on the current specific task, one may use horizontal splitter to enlarge either teams/games (top) area, or the odds (bottom) area of the main form:

- **Status bar**

Table of standings is activated either by choosing menu item Teams → Show standings, or by clicking a button on a tool bar.

To count standings correctly, program uses the following attributes in the column Rem of the games.
All games that have been played on or after the date of the game marked by **F**, excluding cup and friendly games, are taken into account when counting standings.

For Internet-updateable leagues, such attributes are added automatically.

If two or more teams have an equal number of points, then certain rules are applied to determine the higher placed teams. It is possible to change (customize) these rules for special needs by pressing a button **Groups & Rules**. See section Groups and rules of ranking for details.

Top teams to be promoted to the higher league, are highlighted by red. Bottom teams to be relegated to the lower league, are highlighted by dark blue. The numbers of promoted and relegated teams are defined in the **Groups & Rules** panel too.

Punitive points affecting standings are specified using menu item **Teams → Punitive points**.

### 2.3 Charts of ratings

Clicking one of menu items of **Charts** menu opens up a new window where the dynamics of changing ratings (in-totals) for teams in a current league is displayed:

User may navigate through periods using arrow buttons (or keys). It is possible to view the whole range by checking a box **Whole**.

Curves can be made smoother by checking a box **Smooth**. Option **3D** changes appearance of the chart to 3-dimensional.

Click **Print** button to make a hardcopy of displayed chart. Printing results are the best when using
color-capable printer.

It is possible to display ratings (in-totals) of home team vs away team by choosing desired item in the submenu **Team vs team**.

**Note:** To display a chart, there must be at least 2 teams and 2 games with different dates. Curves can be displayed only for the first 63 teams from the teams table. For a big database of past games, only the last 500 different dates can be displayed on a chart.

**Note:** Vertical bar in 2D-view indicates beginning of the period when there is enough past games for reliable statistical computations.

## 3 User's tasks

### 3.1 Input of league data

League data is essential for this program. It comprises sets of teams and past games. The more games are entered, the more accurate ratings, in-totals (i.e. contributions to the total), and odds are computed. Teams and games are entered in the teams and games tables, respectively (see User interface). Pairs of playing teams (fixtures) in the odds table are also part of league data.

**Teams and teams table**

Use menu **Teams** to edit teams table. Columns **Rating**, **In total**, **Attack** and **Defence** are editable if an option **Manual input of ratings/in-totals** is turned on. Normally, there is no need to enter ratings and in-totals manually. They are computed automatically, provided that there are enough games for statistical analysis. Maximum 1024 teams can be entered in the teams table.

Punitive points for a certain team are entered as positive integers using menu **Teams → Punitive points**. They are subtracted from the normally calculated points, and thus corrected points are highlighted by red.

**Games and games table**

Use menu item **Games** to edit games table. All columns are editable: **Date**, **Time**, **Home team**, **Away team**, **G1**, **G2** - goals scored by home and away teams, **HT** - half time score, and **Rem** - remarks on a particular game. Remarks (attributes) are optional, they may have the following values: **ot** - overtime, **nv** - neutral venue, **F** - first game in a championship, **c** - cup game, **fr** - friendly game, **?** - doubtful result. Several remarks on a single game are delimited by spaces. Subsequent rows of the games table may contain no date if it remains the same.

Half time scores are displayed in soccers leagues only. If the full time score of either team exceeds 30, then the half time score cannot be displayed.

In tennis leagues, games table has a bit different look. Column **R** contains final or current match result, and columns **1..5** contain final or current results of separate sets. An attribute **gs** designates grand slam match that may consist of up to 5 sets.

Besides of manual input of new games, games table can be updated either via Internet (see Updating leagues via Internet) or from the files in the following formats:

1) League files (**LEA**);  
2) Excel files (**XLS**). Columns on a worksheet must contain the same headers as the games table does.
3) Soccerway files - html source only (HTM or HTML);
4) Obsolete text/html files (UPD) (see Updating league data from text files).

It is possible either through menu item Games → Update from file or using toolbar button 

There is no limit of number of games that may be entered in the games table.

For the user’s convenience, there is a possibility to view just the games and fixtures between two chosen teams (or all games played by a single team). This is done through menu item Games → View games.

- Fixtures and odds table
Odds table is used to specify fixtures and to display odds - results of computations. Fixtures are entered either manually, using dropdown boxes, or through menu item Fixtures → Show new fixtures. User may want to enter custom handicaps, totals, and scores in editable gray columns AHO or H, Total, and Score, respectively. Custom handicaps are entered as negative (positive) number of balls subtracted (added) from the result of home team. They also may be entered in AHO notation, e.g. 0 : 1.25 which is the same as 0 : 1¼ or -1.25, likewise 0.5 : 0 is the same as ½ : 0 or 0.5. Check boxes in the left edge of the table are used to specify neutral venue of the match.

Note: It is recommended to prepare teams table first in order to activate type-assistant while entering games.

Note: Pressing <Enter> or double-clicking enters edit mode in editable cells of either table.

Note: For the user's convenience, each table has a pop-up menu activated by right-clicking a mouse. They are identical to menu items in the main menu.

User can open previously saved league file by clicking a button , or by choosing menu item File → Open. If a league file resides in the Odds Wizard directory, it may be quickly chosen from the dropdown file box on the tool bar. It is recommended to place league files in that directory. League files have default extension LEA.

To clear all the input data and initiate a new league, either click a button on a tool bar, or choose menu item File → New.

To save league data to the file for the further use, either click a button or choose menu item File → Save or File → Save as...

3.2 Computing, viewing, printing, and exporting odds

First, make sure that profit margin is set to zero in order to generate fair odds.

To start computations, either click a button or press a key <F9>.

Ratings and in-totals are computed first, and then odds for all specified fixtures. Computations are fast, so results are displayed immediately.

Computed odds are presented in the odds table (see topic User interface). The exact meaning of its columns is as follows:
<table>
<thead>
<tr>
<th>View / hotkey</th>
<th>Column</th>
<th>Meaning</th>
<th>Meaning in tennis league</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General view</strong></td>
<td>1</td>
<td>Win of home team</td>
<td>Win of player 1</td>
</tr>
<tr>
<td>&lt;F3&gt;</td>
<td>X</td>
<td>Draw</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Win of away team</td>
<td>Win of player 2</td>
</tr>
<tr>
<td></td>
<td>1X</td>
<td>Win of home team or draw</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>Win of either home or away team</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2X</td>
<td>Win of away team or draw</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AH</td>
<td>Asian handicap base (editable)</td>
<td>Asian handicap base for won games (editable)</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Win of home team against AH</td>
<td>Win of player 1 against AH</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Win of away team against AH</td>
<td>Win of player 2 against AH</td>
</tr>
<tr>
<td></td>
<td>EH</td>
<td>European (fixed) handicap base (editable)</td>
<td>European (fixed) handicap base for won games (editable)</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Win of home team against EH</td>
<td>Win of player 1 against EH</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>Draw against EH</td>
<td>Draw against EH</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Win of away team against EH</td>
<td>Win of player 2 against EH</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td>Total number of scored goals (editable)</td>
<td>Total number of played games (editable)</td>
</tr>
<tr>
<td></td>
<td>&lt;</td>
<td>Under - less than Total</td>
<td>Under - less than Total</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td>Over - greater than Total</td>
<td>Over - greater than Total</td>
</tr>
<tr>
<td></td>
<td>Both</td>
<td>Both teams to score</td>
<td>Both players to score</td>
</tr>
<tr>
<td></td>
<td>Not</td>
<td>Not both teams to score</td>
<td>Not both players to score</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td>Score of the match (editable)</td>
<td>Score of the match (editable)</td>
</tr>
<tr>
<td></td>
<td>odds</td>
<td>Odds of the score</td>
<td>Odds of the score</td>
</tr>
</tbody>
</table>

**Correct scores**

| <F4> | 0:0 ... 3:3 | Odds of a particular score | Odds of a particular match score |
|      | [:4:] | All scores with 4 |
|      | Other | Odds of all other scores |

**Asian handicaps**

<p>| &lt;F5&gt; | AH | Shifted (-/+) Asian handicaps | Shifted (-/+) Asian handicaps |
|      | 1  | Win of home team against AH | Win of player 1 against AH |
|      | 2  | Win of away team against AH | Win of player 2 against AH |</p>
<table>
<thead>
<tr>
<th></th>
<th>G1</th>
<th>Number of goals scored by home team (editable)</th>
<th>Number of games won by player 1 (editable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;F6&gt;</td>
<td></td>
<td>Under - less than G1</td>
<td>Under - less than G1 games</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Over - greater than G1</td>
<td>Over - greater than G1 games</td>
</tr>
<tr>
<td>G2</td>
<td></td>
<td>Number of goals scored by away team (editable)</td>
<td>Number of games won by player 2 (editable)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Under - less than G2</td>
<td>Under - less than G2 games</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Over - greater than G2</td>
<td>Over - greater than G2 games</td>
</tr>
<tr>
<td>1, 2, 3, 4, 5</td>
<td></td>
<td>Total goals = 1, 2, 3, 4, 5</td>
<td>Total sets = 2, 3, 4, 5</td>
</tr>
<tr>
<td>0..1</td>
<td></td>
<td>Total goals = 0 or 1</td>
<td></td>
</tr>
<tr>
<td>2+</td>
<td></td>
<td>Total goals = 2 or more</td>
<td></td>
</tr>
<tr>
<td>1..2</td>
<td></td>
<td>Total goals = 1 or 2</td>
<td></td>
</tr>
<tr>
<td>0..2</td>
<td></td>
<td>Total goals = 0, 1 or 2</td>
<td>Total sets = 2</td>
</tr>
<tr>
<td>3+</td>
<td></td>
<td>Total goals = 3 or more</td>
<td>Total sets = 3</td>
</tr>
<tr>
<td>2..3</td>
<td></td>
<td>Total goals = 2 or 3</td>
<td></td>
</tr>
<tr>
<td>1..3</td>
<td></td>
<td>Total goals = 1, 2 or 3</td>
<td></td>
</tr>
<tr>
<td>0..3</td>
<td></td>
<td>Total goals = 0, 1, 2 or 3</td>
<td>Total sets = 3 (for grand slam)</td>
</tr>
<tr>
<td>4+</td>
<td></td>
<td>Total goals = 4 or more</td>
<td>Total sets = 4 or 5 (for grand slam)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>&lt;F7&gt;</th>
<th>Shifted (-/+ total number of goals)</th>
<th>Shifted (-/+ total number of games)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Under - less than Total</td>
<td>Under - less than Total</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Over - greater than Total</td>
<td>Over - greater than Total</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>&lt;F8&gt;</th>
<th>Win of home team in 1st time</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Draw in 1st time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in 1st time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of home team in 2nd time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Draw in 2nd time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in 2nd time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of home team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of home team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>draw in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of home team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>win of away team in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Draw in half time and win of home</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>team in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Draw in half time and in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Draw in half time and win of away</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>team in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>win of home team in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>draw in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>draw in full time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win of away team in half time and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>in full time</td>
<td></td>
</tr>
</tbody>
</table>

Editable columns enable user easily get desired odds against custom handicaps, totals or scores. In response to pressing <Enter> key, program displays new odds immediately.

Printing of odds tables is accomplished either by clicking a button, by choosing menu item File →
Print odds, or by pressing a hotkey combination Ctrl-P.

Registered users can export generated odds and tables of standings to Excel (XLS) or comma-delimited (CSV) files. This is done through menu item File → Export to file, or by pressing a hotkey combination Ctrl-E.

Odds for all available leagues can be exported to a single Excel file by choosing menu item File → Export all odds, or by pressing a hotkey combination Ctrl-Alt-E.

Printing and exporting of odds is controlled by pop-up dialogue boxes, where it is possible to choose which items should be sent to printer or file. Corresponding settings are contained in the Options → Misc panel too. This helps user to save a paper and a disk space.

Note: Asian handicap bases and totals may have either integer or fractional value. In case of their integer value, equalizing outcome of an event is 'cancelled'.

Note: Beware of the last games in a season (tournament)! Some teams may have already lost their tournament motivation, while others are still fighting for the first places or whatsoever. This may result either in fixing a game, or in the inadequate team composition (e.g. to save the best players from possible injuries).

Note: Odds Wizard computes performance-based odds only. It does take into account human factors.

3.3 Feeding odds to Stake Wizard

Every fair odds can be easily fed to Stake Wizard tool using either menu item Odds → Feed to Stake Wiz, or the hotkey combination <Ctrl-F>, or simply by double-clicking on the odds cell.

To enable this feature for a particular odds of a particular event, mouse pointer must be positioned on a corresponding cell of either odds table.

Up to 26 various odds can be fed in a single stake (STK) file. It is recommended to choose independent events/odds for feeding to Stake Wizard.

When the option Options → Stake Wizard → Automatically feed line odds is turned on, available market line odds are fed along with corresponding fair odds. Otherwise line odds have to be entered manually by the user in the column Line of the bets table. To make the line odds available for viewing and feeding, press a key <F2>. To make them instantly available, turn on the option Options → Internet → Automatically fetch line odds. The latter option is available for registered users only.

3.4 Updating leagues via Internet

Over 100 soccer and hockey leagues, NHL, NFL, NBA, MLB, ATP, and WTA can be easily updated via the Internet connection.

Currently soccer leagues of the following countries are supported: England, Germany, Italy, Spain, France, Portugal, Holland, Belgium, Russia, Ukraine, Finland, Scotland, Austria, Sweden, Norway, Denmark, Greece, Turkey, Switzerland, Ireland, Poland, Czechia, Slovakia, Serbia, Bulgaria, Croatia, Slovenia, Romania, Israel, Iceland, Hungary, USA, Mexico, Argentina, Brazil, Australia, China, Japan, S.Korea, Chile, Cyprus, Montenegro, Colombia, Peru, India, Vietnam, Bosnia & Herzegovina. More leagues are to be added further.

Connect to the Internet and start updating leagues by choosing menu Internet with an options to update either current league only, express update, or basic update of all leagues and fixtures. The
latter option can be implemented also by clicking radar button on a tool bar. Interrupted update can be resumed, starting from the last point.

The progress of Internet updates and their results are displayed on the form:

![Updating leagues via Internet](image)

**Note:** Leagues are updated on a daily basis. Server updates occur approximately at midnight GMT.

**Note:** The latest results may be obtained faster by choosing menu item Internet → Express update of current/all leagues, or by initiating display of live results/odds using a toolbar button.

### 3.5 Live results and odds

Live results and corresponding live odds are initiated by clicking a button on a tool bar. Afterwards, they are refreshed every 5 seconds. Computer must be connected to the Internet to perform this operation.

Live results are displayed in the **Live score table** at the left side of odds table within the main form. Corresponding live odds are automatically recalculated upon any change in live score table.

Using either toolbar button or menu item **Fixtures → All live games**, it is possible to display all available in-play games in the current sport.

Live results and odds are provided for the most soccer leagues.

NHL, several European hockey leagues, MLB, NFL, NBA, ATP and WTA are also covered.

### 3.6 Updating league data from text files

Generic update file format complies to the following text file specification:

```
May 15, 2009   Montpellier     - Lyon             2 - 2
            St.Etienne      - Monaco           3 - 1
            Le_Havre        - Nantes           0 - 1
---------------------------------------------------------
123456789012345678901234567890123456789012345678901234567890123456789012345678901234567890123456789012345678901234567
```

Subsequent rows may contain no date if it remains the same.
The above text file format is an obsolete in version 1.80 and higher. It is retained for the backward compatibility. In particular, it allows only 15 characters in the team names.

### 3.7 Renaming many teams

Using menu item **Teams → Rename many teams**, it is possible to rename many teams at once according to rename rules in the text file. Text file must contain rename rules in the form of the following strings:

New team1 name="Old team1 name1";"Old team1 name2";...
New team2 name="Old team2 name1";"Old team2 name2";...
New team3 name="Old team3 name1";"Old team3 name2";...

and so on.

Text file name is **Rename.ren** by default. When choosing this command, user is prompted to change the name of text file if necessary.

The scope of rename file spans all upper folders with respect to the program directory `\Oddswiz\` unless they contain another rename files. For instance, renaming teams in the league file `\Oddswiz\Austria\Bundesliga2021.lea` will obey rename rules of `\Oddswiz\Austria\Rename.ren` even though the folder `\Oddswiz\` does also contain another file `Rename.ren`.

This feature simplifies the data link with the tool **Data retriever** which may offer the same teams but with an essentially different names.

### 3.8 If you are a bookie

Setting an option **Profit margin** to a value between 10-20% enables user to generate bookie's line odds (prices). They are usually rounded to 0.05.

Typical rounded line odds generated by **Odds Wizard** may look like:

<table>
<thead>
<tr>
<th>N</th>
<th>Team (Home)</th>
<th>Team (Away)</th>
<th>Kickoff</th>
<th>Status</th>
<th>1</th>
<th>2</th>
<th>1X</th>
<th>2X</th>
<th>AH</th>
<th>1</th>
<th>2</th>
<th>Total</th>
<th>&lt;</th>
<th>&gt;</th>
<th>Bath</th>
<th>Net</th>
<th>Score</th>
<th>Odds</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RB Leipzig</td>
<td>Hertha BSC Berlin</td>
<td>17-12-18 30</td>
<td>To start</td>
<td>1.5</td>
<td>3.65</td>
<td>5.9</td>
<td>1.96</td>
<td>1.2</td>
<td>1.25</td>
<td>-0.75</td>
<td>1.7</td>
<td>1.95</td>
<td>2.5</td>
<td>1.75</td>
<td>1.85</td>
<td>1.85</td>
<td>1.85</td>
</tr>
<tr>
<td>2</td>
<td>SV Werder Bremen</td>
<td>1. FC Klee</td>
<td>17-12-18 30</td>
<td>To start</td>
<td>2.8</td>
<td>3.25</td>
<td>2.06</td>
<td>1.5</td>
<td>1.25</td>
<td>1.25</td>
<td>-0.25</td>
<td>1.65</td>
<td>1.95</td>
<td>2.75</td>
<td>1.65</td>
<td>1.85</td>
<td>1.4</td>
<td>2.8</td>
</tr>
<tr>
<td>3</td>
<td>FC Augsburg</td>
<td>Borussia Mönchengladbach</td>
<td>17-12-18 30</td>
<td>To start</td>
<td>2.6</td>
<td>3.05</td>
<td>2.66</td>
<td>1.4</td>
<td>1.3</td>
<td>1.4</td>
<td>0</td>
<td>1.8</td>
<td>1.16</td>
<td>2.5</td>
<td>1.7</td>
<td>1.95</td>
<td>1.55</td>
<td>2.15</td>
</tr>
<tr>
<td>4</td>
<td>1. FSV Mainz 05</td>
<td>Hamburger SV</td>
<td>17-12-18 30</td>
<td>To start</td>
<td>1.55</td>
<td>3.65</td>
<td>6.2</td>
<td>1.1</td>
<td>1.2</td>
<td>2.1</td>
<td>-0.75</td>
<td>1.8</td>
<td>1.8</td>
<td>2.5</td>
<td>1.8</td>
<td>1.8</td>
<td>1.6</td>
<td>2.05</td>
</tr>
<tr>
<td>5</td>
<td>FC Schalke 04</td>
<td>SC Freiburg</td>
<td>17-12-18 30</td>
<td>To start</td>
<td>1.75</td>
<td>3.6</td>
<td>4.06</td>
<td>1.15</td>
<td>1.2</td>
<td>1.86</td>
<td>-0.5</td>
<td>1.75</td>
<td>1.95</td>
<td>2.75</td>
<td>1.95</td>
<td>1.75</td>
<td>1.75</td>
<td>1.75</td>
</tr>
<tr>
<td>6</td>
<td>VfL Wolfsburg</td>
<td>Eintracht Frankfurt</td>
<td>17-12-18 30</td>
<td>To start</td>
<td>1.95</td>
<td>3.05</td>
<td>3.7</td>
<td>1.2</td>
<td>1.3</td>
<td>1.65</td>
<td>-0.5</td>
<td>1.65</td>
<td>1.65</td>
<td>2.25</td>
<td>1.75</td>
<td>1.85</td>
<td>1.55</td>
<td>1.55</td>
</tr>
<tr>
<td>7</td>
<td>SV Darmstadt 98</td>
<td>FC Bayern Munich</td>
<td>18-12-18 30</td>
<td>Fixture</td>
<td>19.7</td>
<td>6.7</td>
<td>1.1</td>
<td>5</td>
<td>1.96</td>
<td>+1.75</td>
<td>1.65</td>
<td>1.75</td>
<td>2.75</td>
<td>1.95</td>
<td>1.7</td>
<td>2.85</td>
<td>1.0</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>Bayern 04 Leverkusen</td>
<td>FC Ingolstadt 04</td>
<td>18-12-18 30</td>
<td>Fixture</td>
<td>1.3</td>
<td>4.35</td>
<td>8.7</td>
<td>1</td>
<td>1.15</td>
<td>2.9</td>
<td>-1.25</td>
<td>1.3</td>
<td>1.7</td>
<td>2.5</td>
<td>1.95</td>
<td>1.7</td>
<td>1.75</td>
<td>1.85</td>
</tr>
</tbody>
</table>

Exporting such odds for all leagues may produce a huge Excel file with as many as 120 printable pages containing over 50,000 various odds for almost every taste. Exporting option is available for registered users only.

**Note:** Line odds generated by **Odds Wizard** in this way may differ from the market values, in particular because of actual betting volumes on certain events are not counted. It is a good idea for a real bookmaker to use **Odds Wizard** as an advisory tool, e.g. to correct **average market odds** in a direction shown by the program.

### 4 Options

Options form is activated by menu item **Options**.

© 1999-2022 Newhaven Software Ltd
It has five tabs: **Common**, **Current league**, **Internet**, **Stake Wizard**, and **Misc**.

First two tabs, **Common** and **Current league** (e.g. **Scotland**) have an identical sets of available league options. **Common** options are used as initial options for new leagues, and to store defaults for the leagues using an option **Use common options**. All options in the tab **Current league** are league-specific.

**Internet** tab has some Internet options.

**Stake Wizard** tab displays options available in Stake Wizard betting tool.

**Misc** tab contains some printing and exporting settings.

### 4.1 Current league options

#### Options

<table>
<thead>
<tr>
<th>Tab</th>
<th>Scotland</th>
<th>Internet</th>
<th>Stake Wizard</th>
<th>Misc</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>League name</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sport</strong></td>
<td>Soccer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Computation algorithm</strong></td>
<td>2015</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Home advantage, balls</strong></td>
<td>0.245</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Profit margin, %</strong></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Depreciation period, days</strong></td>
<td>900</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Trend comparison base, days</strong></td>
<td>200</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Show new fixtures, rounds</strong></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Round date tolerance, days</strong></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Use common options**

- **Cancel**

- **Help**

- **OK**

#### Current league options

- **League name**
The correct league name. League name is displayed on various forms and printed materials.

- **Sport**
Available sports are soccer, ice hockey, baseball, American football, rugby, and basketball. It is important to specify correct sport for a given league as this has an effect on how league data is interpreted by the program.

- **Computation algorithm**
New computation algorithm (2015) optimizes performance against new reliable criterion - entropy of successful probabilities. It is recommended to set the latest computation algorithm.

- **Home advantage, balls**
When the option **Manual input of ratings/in-totals** (see below) is turned on, user must enter here average home advantage for a given league, in balls. Typical home advantage is about 0.5 balls in a
soccer leagues.

- **Profit margin, %**
  Set profit margin to zero to generate fair odds, and to 10-20% to generate bookmaker's line odds. This option allows negative values too for special purposes.

- **Depreciation period, days**
  Program uses past games in the statistical evaluation of ratings and in-totals. New games are valued higher than old ones. Past games are completely ignored if they are older than depreciation period. Typical depreciation period is about 900 days in a soccer leagues. It is possible to set fixed starting date of depreciation period so that its duration will gradually grow. Toggle these modes by double-clicking depreciation period control.

- **Trend comparison base, days**
  Comparison period for trends calculations. Shorter period may not capture long-term trends, and vice versa. Default value 200 days.

- **Show new fixtures, rounds**
  The number of rounds of future games to be used as fixtures. Fixtures are gotten from the league files updateable via Internet.

- **Round date tolerance, days**
  When new fixtures are gotten from the league file, this value is used to determine the date range of a single round. For example, in a soccer league round may start on Friday, with the last game held on Monday.

- **Groups and rules of ranking...**
  Pressing this button opens up the panel Groups and rules of ranking. Define groups and enter league-specific rules of ranking teams there.

- **Notation of odds**
  There are four available notations of odds: decimal, percent of probability, USA, and UK. UK notation is not recommended for generating of fair odds, as the latter require greater precision.

- **Handicap odds**
  Use this option to specify the kind of handicap odds: Asian or fixed. Asian odds (AHO) may have integer, half-integer, or quarter-integer handicap base with no draws. If the match outcome equalizes an integer handicap of AHO, then such event is 'cancelled'. Fixed handicap odds (1 X 2) are similar to the fixed odds, and are equal to them if handicap base is zero.

- **Round odds to**
  When the line odds are to be generated, it is a good idea to round them to 0,05 in decimal notation (or to 5 in USA notation). Fair odds usually require more accuracy for evaluation of possible bets.

- **Exclude draws**
  Some sports may have no draw as a result of a game. In such cases counting draws is meaningless, and they are therefore excluded from any odds by choosing this option.

- **Allow quarter-integral AHO bases**
  This option allows generation of quarter-integral Asian handicap bases, such as 0 : ¼, 0 : ¾, etc., in addition to integral (e.g. 0 : 1) and half-integral (e.g. ½ : 0) bases.

- **Allow quarter-integral totals**
  If checked, program will generate quarter-integral totals (e.g. 2.25) in addition to integral (e.g. 3) and half-integral (e.g. 2.5) values, tending to the maximum balance between unders and overs. Otherwise only integral and half-integral totals will be generated.
• **Manual input of ratings/in-totals**
  Normally, there is no need to enter ratings and in-totals manually if there are enough games for statistical analysis. Sometimes, however, user may want to edit computed values according to his expertise, knowledge of injuries, motivation, etc. It is not recommended to use manual input along with computation algorithm of 2006.

• **Auto calculations on file opening**
  Check this box so that all computations were performed automatically, upon opening (or choosing from the filelist box) another league file. Uncheck the box if you plan to use current league as just a database of past games.

• **Cup games do count**
  Cup games are usually considered as a full-fledged games contributing in ratings and in-totals. Those who believe otherwise, may uncheck this box so that games marked by 'c' in Rem field were ignored in statistical computations.

• **Friendly games do count**
  Friendly games with an attribute 'fr' in Rem field are counted at a half weight. Uncheck this box to ignore friendly games completely in statistical computations.

• **Overtime does count**
  In some sports, such as ice hockey, overtimes are important. This option is used for special treatment of the games marked by 'ot' in Rem field of the games table.

• **Show some old fixtures**
  Causes display of some old fixtures when choosing Fixtures → Show new fixtures. Normally previous round of games is displayed. Behaviour of this option depends on the setting of Round date tolerance.

• **Suspend Internet updates**
  Some leagues may be of no interest to the specific user. Checking this box disables Internet updates for the current league, and thus saves the overall online time.

• **Use common options**
  It is a good idea to specify options for the majority of leagues in the Common tab, and make them used by specific league simply by checking this box.

### 4.2 Groups and rules of ranking

The panel Groups and rules of ranking is activated either from the panels Options, Standings, or from the tool Tournament analysis.
Define groups and enter league-specific rules of ranking teams here, i.e. precedence in case of equality of points between two or more teams. These settings affect further calculations of standings and results of tournament analysis.

Up to 26 groups can be defined. Teams belonging to some group, cannot be included in another one. Groups may have either literal (A, B, C,...), numeral (1, 2, 3,...), or any other naming.

Check the box **Internal games** if only games between teams belonging to the same group should be counted.

To disable grouping, reduce the number of groups down to 0.

Rules of ranking determine the order of priorities between two or more teams with an equal number of points. Typical rules of ranking for the majority of European soccer leagues are as follows:

1. Overall goals difference
2. Overall goals scored
3. Head to head number of points
4. Head to head goals difference

In addition, user can define the number of top teams to be promoted to the higher league, and the number of bottom teams to be relegated to the lower league.
4.3 Internet options

- **Proxy server**
  It is recommended to check the box *Use automatic proxy settings* to enable automatic proxy configuration. In most cases, the program determines proxy server parameters correctly, and whether to use a proxy server at all.

  If the program fails to determine correct proxy server parameters, uncheck the box *Use automatic proxy settings*. Check the box *Use a proxy server*, specify proxy *Address* and *Port* if proxy is needed. Generally, if you succeed in updating leagues via Internet without proxy, then probably no proxy is needed.

  Usually these values match LAN proxy settings of Internet Explorer:

  **Internet Explorer** → **Tools** → **Internet options** → **Connections** → **LAN settings**.

  If you don't succeed, then consult your ISP or LAN administrator about correct proxy values.

- **Automatically download new leagues**
  Check this box so that new leagues appearing from time to time on the server were downloaded automatically.

- **Automatically fetch line odds**
  Check this box to fetch the line odds automatically from the server.

- **Sound notifications of completed updates**
  Turns on a melody when update finishes.
• **Overnight auto update**
  Turns on overnight auto updates of all leagues, either basic, or express, or both.

### 4.4 Stake Wizard options

<table>
<thead>
<tr>
<th>Common</th>
<th>Scotland</th>
<th>Internet</th>
<th>Stake Wizard</th>
<th>Misc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bets</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Auto update status on file opening</td>
<td>✔ Automatically feed line odds</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Check dependencies</td>
<td>✔ Apply team vs team trend hints</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variants</th>
<th>Computations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto select top variants</td>
<td>Default mode</td>
</tr>
<tr>
<td>3</td>
<td>✔ Regular ✔ Kelly</td>
</tr>
<tr>
<td>Bold</td>
<td>Default probability %</td>
</tr>
<tr>
<td>Italic</td>
<td>Default target multiplier</td>
</tr>
<tr>
<td>Underline</td>
<td>Limit accumulators by</td>
</tr>
<tr>
<td>Unselected style</td>
<td>Limit subcomponents by</td>
</tr>
<tr>
<td>Bold</td>
<td></td>
</tr>
<tr>
<td>Selection color</td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td></td>
</tr>
</tbody>
</table>

**Bets**

- **Auto update status on file opening**
  Check this box so that status of chosen bets was updated automatically, upon opening (or choosing from the filelist box) another stake file.

- **Check dependencies**
  Mutually dependent bets (i.e. bets on the same event) cannot be included in accumulators (parlays, etc.). Choose this option to prevent Stake Wizard from generating prohibited bet variants.

- **Automatically feed line odds**
  Enables automatic feeding of available line odds along with fair odds into Stake Wizard's table of bets. It makes a sense when user is going to place bets with bwin.com.

- **Apply team vs team trend hints**
  Check this box to apply trends checking hints by coloring odds cells (shortcut F10). Odds with an unfavorable trends will be colored in a violet. An attempt to feed these odds to Stake Wizard will be accompanied by the warning message.

**Variants**

- **Auto select top variants**
  Upon completing computations, several top bet variants can be selected automatically by choosing
appropriate number. Selected variants are displayed in the form Reports.

- **Selection styles**
  Using these options, user can customize the look of selected and unselected bet variants in the variants table.

**Computations**

- **Default mode**
  Default mode of computations determines the mode of newly created stake files. Actual mode of computations can be set at the control panel on the Stake Wizard main form. Using Regular mode is preferable.

- **Default confidence probability, %**
  Confidence probability is a probability to reach the target fund in a uniform sequence of \(N\) betting rounds. Recommended default value - 95%.

- **Default target multiplier**
  Target multiplier is equal to the ratio (Target fund)/(Available fund). Target fund of newly created stake files is calculated according to this value and the last available user's fund (bankroll). Recommended value is 100.

- **Limit accumulators by**
  This option allows user to limit accumulators to the specified number of ordinary bets. When limiting accumulators e.g. to 2, Stake Wizard generates betting variants like A, B, C, AB, AC, BC, AB+C, AB+BC+AC, etc., but not ABC. Recommended value is 6.

- **Limit subcomponents by**
  The number of subcomponents in a complex bet is equal to \(2^{N-1}\) when no constraints are imposed (\(N\) - number of chosen independent events). From the practical reasons, it cannot be too large. Recommended value is 100. Maximum allowed value is 4095.
4.5 Miscellaneous options

- **Items to print**

  Check appropriate boxes to choose which odds views should be printed. User may have no interest in all the variety of generated odds, and this option helps to save a paper.

- **Items to export**

  Check appropriate boxes to choose which odds views and should be exported to Excel (XLS) or comma-delimited (CSV) file. User may have no interest in all the variety of generated odds, and this option helps to save a disk space by creating smaller files.

  In addition, two another check boxes *Ask before...* and *Ask once* can be used to control the behavior of pop-up dialogue boxes appearing before printing and exporting.

- **Suppress display of diacritic characters**

  Check this box to suppress display of diacritic characters in the names of teams. These characters are usually incorrectly displayed in the non-Latin locales (e.g. Chinese, Cyrillic, etc.), and may spoil the normal look of the program. Option requires restart of program to take an effect.

5 Tools

5.1 Odds converter

Odds converter is activated either by choosing menu item **Tools → Odds converter**, or by clicking a button on a tool bar.
• Basic panel

Odds are converted between four available notations: decimal, percent of probability, USA, and UK. It is possible to input odds using either keyboard or mouse:

- Decimal notation: 1..infinity
- Percent of probability: 0..100%
- USA notation: -infinity..-100, even, 100..infinity
- UK (fractional) notation: 0..1, even, 1..infinity

Depending on the specific needs, user may choose between three grades of output precision: high, normal, and rounded.

Those who are reluctant to click a button Convert, may use auto-conversion function by checking a box Auto conversion.

It is possible to view a reciprocal value of resulting odds by checking a box Reciprocal. Reciprocal value is calculated as a supplement to the 100% probability of a given event.

• 1 X 2 panel

1X2 fixed odds (prices) are converted here to Asian handicaps, total goals, and correct scores. In addition, converter calculates actual profit margin or uses user-defined value.
User can define any profit margin in the editable input box, and then calculate corresponding fixed odds, Asian handicaps, total goals, and correct scores by clicking a button Convert. Clicking a button Set 0% quickly sets profit margin to zero and displays fair odds.

AHO base, total goals base, and the most likely correct score are displayed in the editable boxes too. User can specify any value of AHO, total goals and correct score there, and calculate respective odds either by clicking a button Convert or by pressing <Enter>.

Clicking a button Reset discards user-defined bases and reverts all to automatic values.

**Note:** In principle, reverse conversion of Asian handicaps to fixed odds is possible, provided that total goals odds are known too.

### Arbitrage panel

Arbitrage betting (aka surebet or arb) is a risk-free opportunity to make a guaranteed profit on a particular sporting event or betting market. It exploits differences in odds being offered between a number of bookmakers, typically two or three.

Arbitrage betting is possible when the odds \( L_1, L_2, \ldots, L_k \) on mutually exclusive \( k \) outcomes of the same event meet simple criterion (in decimal notation): \( P = 1/L_1 + 1/L_2 + \ldots + 1/L_k < 1 \). Profit margin of a hypothetical bookmaker in % is determined as \( 100*(1 - 1 / P) \), and normally must be negative.

Individual stakes for the outcomes 1, 2, ... are calculated as \( A / P / L_1, A / P / L_2 \), and so on, where \( A \) is an investment amount. Then expected bettor's profit is calculated as \( A*(1 / P - 1) \), and normally must be positive.

All these calculations for two or three outcomes are performed on the **Arbitrage** panel by clicking a button Convert or by pressing <Enter>: 

![Arbitrage panel screenshot](image)
First two outcomes (1, 2) are usually assumed to be wins of one or another team in a match (draw no bet) or event of type Yes/No. For just two outcomes third editable field must be left blank. Third outcome (X) is optional and assumed to be a draw for the fixed odds of type 1-X-2.

**Note:** In case of arbitrage criterion is not met, expected profit is negative and highlighted in red while the program signals a beep.

### 5.2 Stake Wizard 4

The tool Stake Wizard generates an optimal betting strategy, and thus helps to stop wasting money in a blind betting. Using advanced probability analysis, it does directly instruct bettor as of what betting variant is preferable, as well as of the specific betting fund distribution.

It is activated either by choosing menu item **Tools → Stake Wizard**, or by clicking a button on a tool bar.

Detailed information on this powerful tool can be found in the Chapter Stake Wizard Guide.

### 5.3 Tournament analysis

Tournament analysis tool solves the following tasks:

- Computes odds (probabilities) for each team to be on a certain place upon completion of scheduled games;
- Computes the most probable scenario for each possible pairing "team vs place";
- Computes hypothetical table of standings for the most probable scenarios.
- Computes table of scores for the past games of a tournament.

It is activated either by choosing menu item **Tools → Tournament analysis**, or by clicking a button on a tool bar.

To start analysis, either click a button, press a key <F9>, or choose menu item **Run → Start**.
Computation time depends on the number of scheduled games as a power of 3, and thus may be
tremendous. User however has an option to choose between speed of calculation and desired
accuracy using the track control on a tool bar. To stop lengthy computations, either
click a button, press a key <F10>, or choose menu item Run → Stop.

• Odds table

Computed odds are presented in the odds table:

<table>
<thead>
<tr>
<th>N</th>
<th>Teams \ Places</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hearts</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Celtic</td>
<td>0.6</td>
<td>0.44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Hibernian</td>
<td>1.1</td>
<td>1.37</td>
<td>4.85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Kilmarnock</td>
<td>0.27</td>
<td>30</td>
<td>43.2</td>
<td>12.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Rangers</td>
<td>10.3</td>
<td>65.5</td>
<td>31.7</td>
<td>2.48</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Aberdeen</td>
<td>0.054</td>
<td>14</td>
<td>56.6</td>
<td>23.3</td>
<td>5.05</td>
<td>0.238</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Motherwell</td>
<td>0.177</td>
<td>28.4</td>
<td>45.1</td>
<td>22.7</td>
<td>4.16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Inverness</td>
<td>15.9</td>
<td>37.7</td>
<td>46.4</td>
<td>0.002</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Dundee United</td>
<td>15.7</td>
<td>35.1</td>
<td>49.1</td>
<td>0.063</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Dundee United</td>
<td>0.064</td>
<td>53.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Colored cells represent possible pairings “team vs place”. The darker the color, the more chances has
a team to occupy the place.

There are four available notations of the figures in the odds table: decimal, probability %, USA, and UK.
Probabilities are used by default. Sum of probabilities in each column, and in each row is equal to
100%.

Notations can be easily switched by clicking menu item Odds → Notation, or using pop-up menu.

Clicking a mouse on any colored cell of odds table produces immediate response in two other tables:
games table, and hypothetical standings table.

• Games table and scenarios

<table>
<thead>
<tr>
<th>N</th>
<th>Home team</th>
<th>Away team</th>
<th>G1</th>
<th>G2</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>46</td>
<td>Hearts</td>
<td>Rangers</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Kilmarnock</td>
<td>Falkirk</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Motherwell</td>
<td>Hibernian</td>
<td>1</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Aberdeen</td>
<td>Motherwell</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Dundee United</td>
<td>Kilmarnock</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Falkirk</td>
<td>Hearts</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Hibernian</td>
<td>Inverness</td>
<td>W</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Livingston</td>
<td>Inverness</td>
<td>L</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>Rangers</td>
<td>Dundee United</td>
<td>2</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Games table keeps all played, and some scheduled games of the current tournament. They
correspond to all games in the games table of main Odds Wizard screen without cup (c) attribute, and
not older than the first game of the tournament (denoted by F). Scheduled games have light-gray
background to be distinct from others. Column R displays the most probable scenario for the chosen
pair team vs place using the following set of symbols:
Columns G1, G2 represent actual scores of the past games, and the most probable scores for the scheduled games. Scores of some scheduled games are conditioned by the scenario. For example, while the most probable score of some game is 1:0, taking part in a scenario as "draw" makes the most probable score of that game e.g. 1:1. Scheduled games that are not included in the scenario, are grayed.

**Hypothetical standings table**

<table>
<thead>
<tr>
<th>N</th>
<th>Teams</th>
<th>G</th>
<th>W</th>
<th>D</th>
<th>L</th>
<th>S</th>
<th>C</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hearts</td>
<td>9</td>
<td>6</td>
<td>1</td>
<td>0</td>
<td>22</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>2</td>
<td>Celtic</td>
<td>9</td>
<td>7</td>
<td>1</td>
<td>1</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>Hibernian</td>
<td>9</td>
<td>6</td>
<td>1</td>
<td>2</td>
<td>15</td>
<td>8</td>
<td>19</td>
</tr>
<tr>
<td>4</td>
<td>Rangers</td>
<td>9</td>
<td>5</td>
<td>1</td>
<td>3</td>
<td>15</td>
<td>9</td>
<td>16</td>
</tr>
<tr>
<td>5</td>
<td>Kilmarnock</td>
<td>9</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>13</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>6</td>
<td>Aberdeen</td>
<td>9</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>11</td>
<td>10</td>
<td>12</td>
</tr>
<tr>
<td>7</td>
<td>Motherwell</td>
<td>9</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>20</td>
<td>20</td>
<td>11</td>
</tr>
<tr>
<td>8</td>
<td>Dundee United</td>
<td>9</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>12</td>
<td>16</td>
<td>9</td>
</tr>
<tr>
<td>9</td>
<td>Inverness</td>
<td>9</td>
<td>2</td>
<td>2</td>
<td>5</td>
<td>8</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>10</td>
<td>Falkirk</td>
<td>9</td>
<td>1</td>
<td>3</td>
<td>5</td>
<td>18</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

This table displays hypothetical standings for the most probable scenario of the chosen pair team vs place (e.g. Hibernian on 3rd place). Columns **G, W, D, L, S, C, P** denote the total number of: played games, wins, draws, losses, goals scored for, goals scored against (conceded), and points, respectively.

**Table of scores**

<table>
<thead>
<tr>
<th>N</th>
<th>Home \ Away</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Celtic Glasgow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0:0</td>
</tr>
<tr>
<td>2</td>
<td>Glasgow Rangers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Dundee United</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0:0</td>
</tr>
<tr>
<td>4</td>
<td>Hibernian Edinburgh</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Motherwell FC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1:2</td>
</tr>
<tr>
<td>5</td>
<td>Kilmarnock FC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2:1</td>
</tr>
</tbody>
</table>

Table of scores can be displayed either by using menu item Table → Score table, or by pressing a key <F3>. This table displays scores of past games in a tournament. User may switch back to odds table by pressing a key <F2>.

**Note:** Both odds and scores tables can be exported to Excel (XLS) file using menu item Table → Export table.

**Note:** Tournament analysis tool has the following limitations for the input data:
Maximum number of teams 32
Maximum number of past games 1250
Maximum number of scheduled games 96

5.4 Data retriever

Data retriever is a utility that searches Internet web sources and retrieves sports results and fixtures for soccer, ice hockey, basketball, baseball, rugby union, American football, handball, and volleyball. It covers a great variety of championships and other competitions. Several options allow to get either latest or the whole results, supply games with some attributes, automatically rename the teams, and save the data in the league (LEA) format. Simple and intuitive interface makes it easy to get and save large arrays of data very quickly.

The tool Data retriever is activated either through menu item Tools → Data retriever or using toolbar button 🔄.

Note: All Data retriever features are available in a full (registered) version only.

Note: When saving data with Rename option, Data retriever uses the same rules and files as described in the topic Renaming many teams.

Green plus button at the right bottom corner updates current league with retrieved data without having to save it into the file.
• Adding a custom league

First, make sure that past results and future fixtures are present in Data retriever.

1. Save league data to a league file using button at the right bottom corner.
2. Open that file in Odds Wizard.
3. Add files for past seasons using Games → Update from file.
3.1. Determine participating teams. Take all the teams and games during the last 3 seasons + current season in e.g. League 2. This is easily done by checking filter options Add teams, Add games, and Add fixtures when using Games → Update from file.
3.2. Update the league from at least 3 last seasons in League 1, 2, 3, 4, etc. using just an option Add games. Take as many last seasons as you want for historical performance analysis and charts, but remember that only those games affect ratings and odds that are not older than depreciation period (Options → Depreciation period). It has default value 900 days for most leagues (~ 2.5 seasons).
4. Make necessary settings in the Options panel. In particular set the name of the league exactly in the format: Country - Name of the League.
5. Click green arrow button on a toolbar.
6. Use Fixtures → Show new fixtures to display fixtures and odds.

Note: League file must have country prefix, without any spaces, e.g. MyCountry1.lea.

Note: Data retriever is just a tool to retrieve and save league data from the web sources. All further work is done by Odds Wizard.

5.5 Games filter

The tool Games filter is an instrument for analysis of past games meeting various conditions: participating teams, seasons, first time / full time results, outcomes, correct scores, handicaps, totals, games attributes.

The tool Games filter is activated either by choosing menu item Tools → Games filter, or Games → View games → Use filter..., or by clicking the button on the tool bar.
5.6 Performance analysis

The tool Performance analysis is activated through menu item Tools → Performance analysis.
This utility generates statistics of successfully computed odds (probabilities) in a given league. Results of computation can be regarded as a general index to the joint action of the following concurrent factors:

1. Performance of **Odds Wizard** itself;
2. Predictability of the current league.

To start analysis, click a button **Calculate**. Calculated success rates are presented in two tables. The first table has the following exact meaning of its columns:

<table>
<thead>
<tr>
<th>Number of games</th>
<th>Relative rate, %</th>
<th>Sum of computed probs</th>
<th>Relative rate, %</th>
<th>Successful computed probs</th>
<th>Success rate, %</th>
<th>Entropy of successful probs</th>
<th>Criterion Xi^2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home wins</td>
<td>647</td>
<td>47.4</td>
<td>646.3</td>
<td>41.6</td>
<td>36.1</td>
<td>55.35</td>
<td>0.2906</td>
</tr>
<tr>
<td>Draws</td>
<td>370</td>
<td>23.7</td>
<td>393.7</td>
<td>25.1</td>
<td>86.7</td>
<td>23.96</td>
<td>0.3438</td>
</tr>
<tr>
<td>Away wins</td>
<td>547</td>
<td>35.0</td>
<td>510.6</td>
<td>33.4</td>
<td>253.7</td>
<td>47.48</td>
<td>0.3066</td>
</tr>
<tr>
<td>Total</td>
<td>1564</td>
<td>100</td>
<td>1556.6</td>
<td>100</td>
<td>785.5</td>
<td>126.80</td>
<td>0.9410</td>
</tr>
</tbody>
</table>

| Over 2.5        | 822              | 50.9                  | 870.9            | 60.6                      | 51.47          | 62.62                       | 0.2086         |
| Under 2.5       | 574              | 41.1                  | 566.2            | 38.4                      | 244.6          | 42.61                       | 0.3635         |
| Total           | 1396             | 100                   | 1437.1           | 100                       | 759.3          | 105.23                      | 0.6461         |

The last two sums: of success rates \( PP = 100 \times s_1/n_1 + 100 \times s_X/n_X + 100 \times s_2/n_2 \), and the entropy of successful probabilities are regarded as an integral performance/predictability indices. They are highlighted by bold font. Minimum possible value of an entropy is zero when all outcomes are predicted with an absolute accuracy. The higher values of an entropy mean the less accuracy of prediction.

Second table for overs/unders is similar to that described above.
5.7 **Rename utility**

The tool **Rename utility** enables user to easily handle differences in the same teams names arising from different sources. It is activated through menu item **Tools → Rename utility**. Use it to rename the teams only once. Afterwards, renames will be done automatically. Target (new) name may have several source names.

**Rename utility** form is divided by three list views. Target teams names (names to be renamed to) are highlighted by bold font. Left list view contains full list of all teams names, including old and new ones. Middle list view contains current rename group which consists of target name (bold) and one or more source names. Right list view contains just target names. Selecting any item in the left or right list view causes display of the whole group which that item belongs to.

Available buttons allow to add source and target names, assign names as a target, create new rename groups, delete groups, and add new groups to the rename list.
By default, rename files have standard name **Rename.ren**. This standard name is also used by **Data retriever** tool when saving results of past games or fixtures.

### 5.8 3D balls space

**3D balls space** is a recreational tool that implements soccer balls behaviour in a physical space with or without applied gravity, in accordance to the major conservation laws. In a full screen mode, without walls background, it can be used as an original screensaver.

Several options are available to the user by pressing the following keys:

- **R**: Restart
- **G**: Turn on/off the gravity
- **H**: Movement in a horizontal plane
- **V**: Movement in a vertical plane
- **B**: Movement on a grass (billiard-like)
- **+, =**: Quicken movement
- **-**: Slacken movement
- **S**: Turn on/off sound effects
- **W**: Turn on/off walls background
- **M**: Add more balls
- **L**: Remove balls
- **F / N**: Full / normal screen

The above options are accessible also by right-clicking and choosing an item in a popup menu. The last item in a popup menu **Shortframe...** saves a shortframe of current scene into a bitmap file.

In addition, user can navigate across the scene using the following keys:

- →: Turn right
- ←: Turn left
- ↑→: Shift right
- ↑←: Shift left
- ↑: Move forward
- ↓: Move backward
- ↑↑: Shift up
- ↑↓: Shift down
- PgUp: Look up
- PgDn: Look down
- Home: Revert to initial position

**Note**: Turning on the gravity eventually terminates the movement due to energy loss. However it can be kept up by pressing <-> key from time to time.

**Note**: Kinetic energy loss due to non-elastic interaction between colliding objects is effective only in the
case of applied gravity.

6 Stake Wizard Guide

6.1 Overview and basic concept

Stake Wizard 4 is a new version of decision making software generating an optimal betting strategy. Using sophisticated probability analysis, it does directly instruct bettor as of what bet structure is preferable, as well as of the specific betting fund distribution. Unlike simple programs based on Kelly criterion, Stake Wizard allows to use a realistic range of bankroll growth, and to specify confidence probability of reaching the target fund.

Stake Wizard 4 is powered theoretically by the new theorem, and practically by the new multivariate optimization engine. It has an ultimate performance, and provides greater opportunities for bettor.

Bettor usually places bets intuitively balancing bookie’s odds with against his knowledge of events course. Definitely, player’s task is not easy, since a lot of events/odds offered by bookie are to be put together. Then a decision must follow on how much and in which combinations stake should be made. It is obvious that betting with all available money will sooner or later result in a total loss. From the other side, betting with a small amount gives an opportunity to win nothing much. There must be a happy medium somewhere... and it does exist! Stake Wizard is clever enough to find such a medium for the most profitable combination out from thousands possible.

To use this program efficiently, bettor must understand a simple relationship between probability of event and odds. There are two kinds of odds: line odds (offered by bookmaker), and fair odds. The latter is mere inverse value of event probability. Should the fair odds are equal to the line odds, bookmaker would have a zero profit in the long run, as well as a punter would have no benefit. That is why line odds are always must be less than fair odds as long as bookie wants to have a profit. Otherwise, bettor has preconditions to win and bookie to lose.

Consider the line odds = 2.0. From the viewpoint of a bookmaker, probability of event is less than 1/2.0 = 50%, and this difference makes up his profit margin. Bettor intuitively makes bet on this event if, in his opinion, fair odds are less than 2.0 (say, 1.5), that is probability of event is about 1/1.5 = 67%. These two values are the main input data for the program. And of course, Stake Wizard will generate an optimal bet structure only if the fair odds are less than line odds. Otherwise betting makes no sense!

It is a good idea for serious bettors to use Odds Wizard prediction capabilities to compute performance-based fair odds.

6.2 User interface

Almost all of the Stake Wizard functions are accessible from the main form which also displays a summary of both input and output data. Main form consists of the following elements:

- Menu and tool bar

Use either menu items or tool bar buttons to open and save input files, print form, view reports, update status of bets, start and stop computations, undo changes, activate odds converter, and display help.
Control panel

Control panel is used to adjust major parameters before starting computations: confidence probability (Conf P), available fund (bankroll) (Fund), minimum stake (Min Stk), target fund (Target), minimum reserved amount (Min x0) in % of Fund, mode of computations (Mode), maximum number of events in accumulator bets (Accum), maximum number of subcomponents in a complex bet (S/comp), and whether to include closed bets.

Bets table

Bets table contains ordinary bets along with relevant information. When feeding odds from Odds Wizard, all cells of this table are filled up automatically, except of the last column which can be updated upon completion of an event. Bets table can contain up to 26 various ordinary bets. All cells in this table are editable.

Variants table

This table shows results of computations. See topic Results of computations for details.

Mode of computations and the total number of computed variants are indicated in the status bar below the table.
6.3 Data input

- **Confidence probability**
  Use input box **Conf P** to enter the required confidence probability. Confidence probability is a measure of reliability. It has an effect on the reliable number of rounds required to reach the target fund. Typically, confidence probability is set to 0.95 (default value). This means that 95% of uniform sequences of R95 betting rounds will be successful in achieving the target fund.

- **Available fund**
  Use input box **Fund** to set the available betting fund (bankroll). It must be greater than or equal to the minimum stake.

- **Minimum stake**
  Use input box **Min Stk** to enter allowed minimum stake. Typically, bookmakers set minimum stake between $1 and $10. Minimum stake may also be set to zero (actually to 1 cent).

- **Target fund**
  Specify target fund in the input box **Target** to be greater than available fund. It makes no sense to set this parameter to as much as it's desirable to win in a long run, since fundamental inaccuracy in evaluation of fair odds may result in a progressive accumulation of probability error, and therefore in a dangerous overbetting. Thus, the more accurate fair odds are used, the greater value of **Target** may be specified. Typically, target fund is 10-100 times greater than available fund.

- **Minimum reserved fund**
  Specify minimum reserved fund in % of available fund using the checkbox **Min x0**. It makes a sense for some category of users to specify this value in order to avoid dangerous overbetting.

- **Ordinary bets**
  Ordinary bets are entered into the bets table at rows A, B, C,..., Z either by feeding odds from Odds Wizard (see topic Feeding odds to Stake Wizard), or manually.

<table>
<thead>
<tr>
<th>Bet</th>
<th>Date</th>
<th>League</th>
<th>Home team</th>
<th>Away team</th>
<th>Type of bet</th>
<th>Fair</th>
<th>Line</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>01.10.05</td>
<td>Scotland</td>
<td>Aberdeen</td>
<td>Motherwell</td>
<td>home win</td>
<td>2.28</td>
<td>3</td>
<td>2.2 lost</td>
</tr>
<tr>
<td>B</td>
<td>01.10.05</td>
<td>Scotland</td>
<td>Dundee United</td>
<td>Kilmarnock</td>
<td>draw</td>
<td>3.84</td>
<td>5</td>
<td>0.0 won</td>
</tr>
<tr>
<td>C</td>
<td>02.10.05</td>
<td>Scotland</td>
<td>Falkirk</td>
<td>Hearts</td>
<td>away win</td>
<td>2.1</td>
<td>3</td>
<td>2.2 lost</td>
</tr>
<tr>
<td>D</td>
<td>02.10.05</td>
<td>Scotland</td>
<td>Hibernian</td>
<td>Inverness</td>
<td>chance 1X</td>
<td>1.32</td>
<td>1.6</td>
<td>1.2 lost</td>
</tr>
<tr>
<td>E</td>
<td>01.10.05</td>
<td>Scotland</td>
<td>Livingston</td>
<td>Celtic</td>
<td>chance 12</td>
<td>1.2</td>
<td>1.5</td>
<td>0.5 won</td>
</tr>
</tbody>
</table>

Up to 26 ordinary bets can be entered. User may edit all bets table entries. When certain cell is selected in the non-edit mode, pressing the key combination <Ctrl-Del> deletes current bet. Pressing <Ctrl-Ins> inserts blank bet at the current row. Edit mode is toggled by pressing the key <F2>. If bets are entered manually, at least two columns must be filled up: fair odds and line odds in decimal notation.

To update status of ordinary bets, either click a button on a tool bar, or choose menu item **Bets → Update status**.

**Note:** Line odds must be greater than corresponding fair odds. Otherwise betting makes no sense!

User may also open previously saved input file by clicking a button , or by choosing menu item **File → Open**. If input file resides in the Odds Wizard directory, it may be quickly chosen from the dropdown file box on the tool bar. It is recommended to place input files in that directory.

To clear all the input data and enter new set of bets, either click a button on a tool bar, or choose menu item **File → New**.
To save input data along with selected betting variants to the file, either click a button on a tool bar, or choose menu item File → Save.

6.4 Running computations

Make sure that all chosen elementary bets meet the condition Fair < Line.

To start computations, either click a button, press a key <F9>, or choose menu item Run → Start.

Computation time depends mainly on the following factors:

- Number of chosen independent bets (A..Z);
- Settings of the options Limit accumulators by and Limit subcomponents by. The less values are chosen, the less time is required (see Stake Wizard options). At the same time, less values mean more constrained output with less expected winnings.
- Minimum stake limitation (Min stk on the Control panel). Zero value may produce huge output with longer computation time.

Number of possible bet structures (betting variants) depends on the number of independent bets as power of 2 minus 1. For example, for three independent bets A, B and C, possible $2^3-1 = 7$ variants of betting are:

1) A - single bet;
2) B - single bet;
3) C - single bet;
4) \{AB\} - single bets A, B, and accumulator bet AB;
5) \{BC\} - single bets B, C, and accumulator bet BC;
6) \{AC\} - single bets A, C, and accumulator bet AC;
7) \{ABC\} - single bets A, B, C, and accumulator bets AB, BC, AC, ABC.

Each of the above bets contains at most $2^N-1$ components, where $N$ - number of events in a given complex bet. Listed constraints however may reduce the number of components, and therefore expected winnings as well.

To stop lengthy computations, either click a button, press a key <F10>, or choose menu item Run → Stop. In such a case set of results will be incomplete, and there’s no guarantee that the optimal betting variant has already been found.

The course of computations is indicated by the progress bar at the bottom of the form.

6.5 Results of computations

Results of computations are presented in the variants output table:

<table>
<thead>
<tr>
<th>Variants</th>
<th>p %</th>
<th>REG</th>
<th>R ave</th>
<th>Z suc %</th>
<th>Z ave %</th>
<th>L</th>
<th>x0</th>
<th>x1</th>
<th>x2</th>
<th>x3</th>
<th>x4</th>
<th>x5</th>
<th>x6</th>
</tr>
</thead>
<tbody>
<tr>
<td>{DEGHIR}</td>
<td>99.2</td>
<td>4.612</td>
<td>6,348</td>
<td>57</td>
<td>63.6</td>
<td>1,648</td>
<td>12,093</td>
<td>E</td>
<td>7,42</td>
<td>ER</td>
<td>R</td>
<td>6.18</td>
<td>DE</td>
</tr>
<tr>
<td>{DEGHIMOR}</td>
<td>99.3</td>
<td>4.626</td>
<td>5,495</td>
<td>54.3</td>
<td>52</td>
<td>1,645</td>
<td>15.79</td>
<td>R</td>
<td>8.48</td>
<td>D</td>
<td>G</td>
<td>5.52</td>
<td>DR</td>
</tr>
<tr>
<td>{DEGHR}</td>
<td>99.2</td>
<td>4.638</td>
<td>6,386</td>
<td>57.2</td>
<td>63.7</td>
<td>1,638</td>
<td>10.27</td>
<td>E</td>
<td>8.08</td>
<td>ER</td>
<td>R</td>
<td>6.73</td>
<td>DE</td>
</tr>
</tbody>
</table>
The exact meaning of its columns is as follows:

- **Variants**: Betting variant (structure).
- **p %**: Reduced probability of success in a single round.
- **R95**: Number of rounds required to reach the target fund with the specified confidence probability (95% by default).
- **R ave**: Average number of rounds required to reach the target fund.
- **Z suc%**: Factor of fund growth in a single successful round (in %).
- **Z ave%**: Average factor of fund growth in a single round (in %).
- **L**: Reduced line odds.
- **x0**: Static fund, i.e. amount to be set aside.
- **x1, x2,...**: Complex bet components, and their amounts.

Betting variant enclosed in curly braces denotes complex multicomponent bet. Complex bet contains a set of all possible accumulator bets (including single bets) composed of elementary bets of a given variant. Set may be incomplete depending on the user's constraints imposed upon the maximum number of accumulator members, maximum number of subcomponents, and the minimum amount of stake.

Clicking headers of the variants table causes results to be sorted. By default, results are sorted by the reliable number of rounds (R95) which is considered the major criterion of betting efficiency in a regular mode. Sorting criterion is indicated by the underlined header.

The total number of computed variants is displayed in the status bar. User may review up to 100 sorted variants by scrolling the lines, however the best ones are shown at the top of the list. No variants requiring more than 10000 rounds are included in the set of results.

Using menu **Variants**, user can select/unselect betting variants, view reports, sort variants, and clear the table. Selected variants are highlighted by the customizable font style and color (see Stake Wizard options). They are saved in stake (STK) files along with the set of ordinary bets. Selecting all variants with further saving may result in a large stake file.

To print main form which displays a summary of both input and output data, either click a button, or choose menu item **File → Print form**.

Input data and results of computation can be exported to Excel (XLS) file using menu item **File → Export to file**.

## 6.6 Betting reports

To view reports on selected betting variants, either click a button on a tool bar, choose menu item **Variants → View reports**, or press a key combination `<Ctrl-R>`.

Reports are presented on the reports form:
Reports summarize major betting parameters: amount of stake, fair and line odds, maximum and actual outcome, gain, status of bet components, probability of success, reliable and average number of rounds.

Components of a complex bet are displayed in a separate columns. The column Sum contains a summary on selected bet.

When user selects a bet from the treeview control at the upper-left corner of the form, report is immediately displayed in the right table. Red arrows indicate successful bets with the positive gain value, while blue arrows show partially or totally lost bets.

Table at the bottom of the form displays the contents and the status of all ordinary bet components. Status of bets can be updated by choosing an item Update status in the popup menu.

- **Printing report**

To print a full report, choose an item Print → Full report either from the upper menu, or from the popup menu. To save paper print just stake coupon by choosing an item Print → Stake coupon.

- **Risk distribution diagram**
To view Risk distribution diagram, choose menu item Diagnostics \(\rightarrow\) Risk distribution. Risk distribution diagram displays distribution of computed probabilities that pertain to the possible levels of the ratio

\[
\text{factor of fund loss/growth} = \frac{\text{bankroll-betting amount+gross winning}}{\text{bankroll}},
\]

also known as return of investment (ROI) if expressed in percent with respect to the bankroll (Fund on the form). Risk distribution diagram shows also consolidated chances to be the loser (minus) and the winner (plus).

- P-diagram

To view P-diagram for selected bet, choose menu item Diagnostics \(\rightarrow\) P-Diagram.

P-diagram displays functional relationship between macro-probability \(P\) and static portion of a bankroll \(k_0\). Relationship has a maximum corresponding to the least number of rounds required to reach the target fund, and an optimal value of the static portion. See topic Mathematical background for details.

### 6.7 Mathematical background

This topic briefs a clear and mathematically strict way to compute an optimal bet parameters in a regular case. The latter means that input parameters don't have their extreme values (e.g. fair odds = 1.01, while the line odds = 5.0), and the minimum stake limitation doesn't have its possible effect.

Unlike simple method based on Kelly criterion, this one allows bettor to use a realistic range of bankroll growth, and to specify confidence probability of reaching the target fund. Two methods give an identical results if the target fund is infinite.

Consider a uniform sequence of \(n\) betting rounds, out from which \(w\) rounds were successful, and \(f\) rounds failed.

As a result of a single successful round, the bankroll will amount to:

\[
x' = x' = Zx = (1 - k_0)k L x + k_0 x,
\]

where
- \(x\) - available betting fund (bankroll);
- \(k_0\) - static portion of fund \(x\);
- \(L\) - reduced line odds;
- \(Z\) - factor of fund growth;

As a result of a single failure, the fund will be dwindled to:

\[
x' = k_0 x.
\]

\(w\) successful rounds and \(f\) failures will result in the target fund:

\[
X^n = Z^n k_0^f x.
\]

Above formulae allow to express \(w\) and \(f\) as a functions of \(x, X, L, n,\) and \(k_0;\)
Probability to have not greater than \( f \) failures prior to collecting as many as \( w \) successes is described by an integral (cumulative) form of Pascal distribution:

\[
\begin{align*}
  w &= \frac{n \ln \left( \frac{X}{x} \right) - n \ln \tilde{k}_0}{\ln[1 + \frac{L}{(1/k_0 - 1)}]}, \\
  f &= \frac{-\ln \left( \frac{X}{x} \right) + \ln \left[ (1 - \tilde{k}_0)L + \tilde{k}_0 \right]}{\ln[1 + \frac{L}{(1/k_0 - 1)}]}.
\end{align*}
\]

Typical functional relationship (\( P \)-diagram) between macro-probability \( P \) and static portion \( k_0 \), provided that \( x, X, L, n, p \) are fixed parameters, has a maximum corresponding to the least number of rounds required to reach the target fund, and an optimal value of the static portion:

In order to obtain an optimal bet parameters, Stake Wizard solves a system of equations:

\[
\begin{cases}
  \frac{\partial P}{\partial k_0} = 0; \\
  P = \alpha
\end{cases}
\]

with respect to the indeterminates: number of rounds \( n \) and static portion \( k_0 \). This is done for each bet structure out from thousands possible.

To apply the above formulae, we need to construct a complex bet, and then represent it as a single component abstract bet having certain values of \( p \) and \( L \) (reduced line odds).

In previous versions of Stake Wizard, bet structures consisted only of independent events. In particular, they did not allow system bets like \( AB + BC + AC \) that reduce betting risks. Regular system bets.
However are far from the optimal bankroll distribution. The following theorem resolves this problem.

**Theorem.** Maximum possible value of an average factor of fund growth $Z$ is achieved by the optimal distribution of a bankroll amongst $2^N - 1$ possible simultaneous stakes, and is determined by the following expression:

$$\ln Z_{ave} = \sum_{i=1}^{N} \left[ \frac{p_i}{q_i} \ln \frac{p_i}{q_i} + (1 - p_i) \ln \frac{1-p_i}{1-q_i} \right],$$

where

- $\ln Z_{ave}$ - mathematical expectation of $\ln Z$;
- $p_i$ - probability of $i$-th event, equal to $1/F_i$, where $F_i$ - fair odds;
- $q_i$ - sportsbook’s ‘probability’ of $i$-th event, equal to $1/L_i$, where $L_i$ - payout coefficients (aka line odds);
- $N$ - number of chosen independent events.

Possible stakes comprise $N$ system bets (combinations) of type $(m, N)$, where $m = 1..N$. Each system bet contains $C^m_N$ $m$-fold accumulator bets. In particular, possible stakes include $N$ single ordinary bets, and one $N$-fold accumulator bet. In general case, optimal system bets are not equipartitioned.

The proof is trivial for a single event with only one possible stake. In the latter simple case, optimal stake is equal to Kelly’s optimum $(p - q)/(1 - q)$. For $N > 1$, the proof is rather complicated even for $N = 2$. However using Stake Wizard’s multivariate optimization engine, one can calculate optimal stakes and verify the theorem numerically for the greater $N$’s.

The above formula means that $Z_{ave}$ can be incredibly high, provided that one has found sufficient number of appropriate events ($F_i < L_i$). But the price is tremendous number of stakes.

For example, for 26 events having $F_i = 1.5$ and $L_i = 1.7$, one should place as many as $2^{26} - 1 = 67108863$ various stakes to achieve 40.2% of an average fund growth in a single round! Practical constraints however, such as minimum stake limitation or the reasonable number of simultaneous stakes, of course reduce the effective value of $Z_{ave}$.

From the viewpoint of conventional betting, there are only two outcomes of a given event: either won or lost elementary bet with probabilities $p_i$ and $1 - p_i$, respectively. Other probability-dependent areas of human activity (e.g. investment management) may involve more outcomes of an event.

In case of multi-outcome events, theorem can be generalized as follows:

$$\ln Z_{ave} = \sum_{i=1}^{N} \sum_{j=1}^{V_i} \left( p_{ij} \ln \frac{p_{ij}}{q_{ij}} \right), \quad \sum_{j=1}^{V_i} p_{ij} = 1,$$

where

- $p_{ij}$ - probabilities of $j$-th outcome in $i$-th event;
- $1/q_{ij} = L_{ij}$ - payout coefficients for $j$-th outcome in $i$-th event;
- $V_i$ - number of possible outcomes in $i$-th event.

In the simplest case of a single event ($N = 1$) with a single outcome ($V = 1$), we would have $p = 1$, $k = 1 - k_0 = 1$, and $Z_{ave} = 1/q = L$.

Equating $Z_{ave}$ and $k$ (total stake portion of a bankroll) of complex bet ($N > 1$) to those values of a single bet, and solving system of equations with respect to indeterminates $p$ and $L$.
\[
Z_{av} = (kL + 1 - k)^p (1 - k)^{1-p}; \\
k = (pL - 1)/(L - 1)
\]

enables to represent multicomponent complex bet as an abstract single bet, and then optimize the value of $k = 1 - k_0$ using macro-probability function.

7 What's new in version 2.90 "Live Magic"

- Market odds are available in all odds views;
- Export of market odds for multiple leagues has been extended to the whole General view;
- Added date-time filter for exported odds;
- Added leagues navigation buttons on a toolbar.

In version 2.80

- Added new tool Rename utility which enables user to easily handle differences in names of the same teams arising from different sources;
- Expanded form Groups and rules of ranking, added points for lost games (in hockey and some basketball leagues);
- Expanded form Performance analysis, added ability to vary depreciation period;
- Updated the tool Data retriever (v3.4).

In version 2.75

- New version of the tool Data retriever (v3.1) works faster and is more reliable; added tennis and rugby league sports;
- Added progress bar on the main form to indicate the process of loading market odds.

In version 2.70

- New tool Games filter allows to analyse past games for various conditions;
- Handball and volleyball added to the tool Data retriever;
- New function Arbitrage added to the tool Odds converter;
- New function added to Trend hints: now it prevents cells from being shaded in green when the market goes up.

In version 2.60

- New feature to display all in-play games on a single form;
- New dropdown box on a toolbar for choosing sport. Now all leagues are broken down by sports;
- New toolbar button for the tool Data retriever;
- New toolbar button for the often used menu command Games \to Update from file.

In version 2.55

- Added market line odds from 9 leading bookmakers for all types of odds;
- New feature in Stake Wizard tool allows to import and merge events from another stake files;
- New option in Stake Wizard tool makes it possible to reserve specified % of a bankroll out of betting;
- Quick switching of fixed odds between 1-X-2 and money line (or draw-no-bet odds).

In version 2.50
• Support of huge leagues with up to 1024 teams or players, and unlimited number of games;
• New computation algorithm (2015) provides better prediction performance;
• New main form design, larger screen, and scrollable odds tables area;
• Greater number of computed odds - over 100 per event, and up to 124 events per league.
• New tool Data retriever searches Internet sites for sports results and fixtures.
• Added Attack and Defence strength variables for better understanding of a team's abilities;
• Added new type of odds Both teams to score along with its alternative;
• Unified games and fixtures table for better handling of fixtures; no more hidden fixtures;
• Automated overnight updates option;
• Improved logic of Update from file function; results, fixtures, and new teams filters;
• Added option Trend comparison base for fine-tuning of trends hints;
• Presentation of Asian handicap base either as a number or m : n;
• More reliable calculations in the tool Odds converter;
• Added ability to add or remove all games attributes in menu Games → Add/remove attributes;
• Added ability to manually edit strength variables of teams in terms of delta amendments to the computed values.

In version 2.20

• Support of three sets of odds in soccer for the match periods: full time, first time and second time;
• Faster in-play updates - live data refreshes every 5 seconds;
• New option to turn on/off sound signal at the end of full updates and export operations;
• Support of fixed starting date of depreciation period in addition to fixed length floating value;
• New menu command Teams → Rename many teams simplifies data link with OW Data Miner.

In version 2.10

• Support of tennis sport;
• Support of huge leagues with up to 511 teams or players, and up to 65535 games;
• Export Stake Wizard input data and results to Excel (XLS) files;
• Ability to suppress display of diacritic characters in the names of teams - essential for non-Latin locales.

In version 2.05

• Display of up-to-date bwin.com market fixed odds 1 - X -2 - 1X - 2X;
• Display of trends analysis hints by coloring the odds cells;
• Export tournament analysis results to Excel (XLS) files;
• Export odds to CSV comma-delimited files (in addition to XLS files);
• Enhanced Stake Wizard 4 user interface and stake (STK) file format;
• Added risk distribution diagrams to Stake Wizard reports.

In version 2.00

• Live results and live fair odds;
• New computation algorithm (2007) optimizes performance against new reliable criterion - entropy of successful probabilities;
• Fixed ‘biased totals’ bug of computation algorithm-2006;
• New algorithm of Stake Wizard 4 provides greater opportunities based upon new theorem;
• Larger form with a horizontal splitter; number of pairings that can be displayed at a time is twice as greater (24);
• Longer teams names, up to 30 characters supported;
What's new in version 2.90 "Live Magic"

- Support of kickoff time and half time results in games table and league files;
- Updates from Excel files;
- Displaying places and points in teams table; support of punitive points;
- Extended performance analysis tool - overs/unders added;
- Enchanced tournament analysis tool - user's choice between speed and accuracy, score table added.

In version 1.96

- Recognition of new format of league files used in the version 2.00 and higher;
- Several minor enchancements.

In version 1.95

- Optimized Internet updates, no more redundant traffic;
- Upgraded recognition algorithm for new soccerway files;
- Automatic LAN proxy configuration.

In version 1.90

- New computation algorithm (2006) provides better performance for most leagues, especially for international competitions;
- Added extended scored goals odds view Totals;
- Added odds view Half / full time;
- Full screen mode in 3D balls space. This tool now can be used as an original screensaver.

In version 1.80

- Totally redesigned Stake Wizard tool;
- Feeding chosen odds to Stake Wizard from Odds Wizard;
- New recreational tool 3D balls room;
- Quarter-integral scored goals support;
- Correct league names;
- Longer teams names, up to 20 characters supported;
- Updating league data from another league (LEA) files, and new soccerway (HTM) files;
- Negative profit margin support for special calculations;
- New option to exclude cup games from computations;
- Indication of promoted and relegated teams in a standings table;
- Viewing all fixtures feature;
- Faster export of odds to Excel (XLS) files;
- Linking a league to a desktop;
- Links to official league web sites, sportsbooks, etc.

Previous enchancements

- Extended capabilities of Odds converter tool, converting 1X2 prices to Asian odds, totals, and correct scores;
- Transfer to a new server, more reliable Internet operations, resume of interrupted updates;
- Support of huge leagues with up to 255 teams and 32768 games;
- Improved algorithms for major operations and tools, less memory consumption;
- New tool Performance analysis measures performance of Odds Wizard and predictability of a given league in terms of success rates;
- New exporting and printing options;
• Export of odds to Excel (XLS) files;
• New tool Tournament analysis computes chances of any team to occupy any possible place;
• New odds table views Correct scores, Asian handicaps, and Totals;
• Full compatibility with Microsoft Windows 98/ME/NT/2000/XP;
• Faster Internet updates; 70+ updateable leagues;
• Support of multiple customizable groups within a league;
• Enhanced user interface and printing capabilities, resizable main screen;
• Shareware (unregistered) version handles up to 16 teams per league.

8 Program registration

Registered version of Odds Wizard is able to compute ratings and odds in leagues with as many as 1024 teams or tennis players, process up to 26 independent events in Stake Wizard tool, and export odds to Excel files.

Registration fee for a full power of Odds Wizard is US $74.95. This fee includes one year subscription. Further annual service renewal fee is $24.95.

There are also other options, including half year subscription for $49.95, two years subscription for $99.95, and unlimited subscription for $199.95.

Any interruption (e.g. for technical reasons) in provision of live scores/odds for more than one day will be counted towards prolongation of the current subscription period.

Registered users are entitled to upgrade to all further versions of this software free of charge.

To register Odds Wizard, choose menu item File → Register, and you'll see a registration panel.

• Online users:

Connect to the Internet. Choose appropriate order language from the dropdown menu. Click a button Order now, and you will be brought to the secure web page to complete the transaction.

Online payment options include credit card, bank/wire transfer, cheque, and cash. In case of payment other than by credit card, registrant is immediately supplied with the order # and further instructions by email.

For the user’s convenience, secure registration page is linked also directly to the start menu of your computer: Start → Programs → Odds Wizard → Secure online registration.

Online payment can be performed through the order page of Odds Wizard as well.

Note: Payment is accomplished on a secure web site which is encrypting all transmitted credit card data according to secure HTTPS protocol.

• Upon registration:

Registration key will be promptly (usually within 24 hours) sent out by email.
Finally, open up registration panel, enter registration key, and press a button Register!.

• Shareware users:

Shareware version of Odds Wizard is fully functional, however it is designedly limited to manage leagues with up to 16 teams (several leagues fit into this), and to process up to 3 events in Stake Wizard tool.
9 Installation notes

Odds Wizard requires status of Windows user’s profile to be administrator at least during the installation and activation process.

In Vista, Windows 7, Windows 8, and Windows 10 Odds Wizard requires to be launched in administrative mode for the normal operation of Internet features: live results and market odds.

All firewall and antivirus programs must recognize Odds Wizard as the safe program. It is recommended to include it in the appropriate whitelist.

Installation file OW290.exe is freely distributable as long as its content remains in the original state.
Installation is prepacked with 32 leagues. All other leagues are automatically downloaded from the server during Internet updates.

10 Acknowledgements

The team of Newhaven Software Ltd. is grateful to the following persons who contributed in the development of Odds Wizard software by valuable comments and suggestions:

- Mr. Pierre Folke, Sweden
- Mr. Wong Kam Fu, Hong Kong
- Mr. Emmanuel Konstandakis, Greece
- Mr. Russell Brownlie, United Kingdom
- Mr. Barry Windsor, United Kingdom
- Mr. Stuart Humphries, United Kingdom
- Mr. Jari Talvitie, Finland
- Mr. Richard Weichelt, Canada
- Mrs. Ivana Kapl-Mikic, Austria
- Mr. Peter Nilsson, Sweden
- Mr. Daniel Irving, United Kingdom
- Mr. Victor Lee, Singapore
- Mr. Andrew Sotiriou, United Kingdom
- Mr. Peter Jensen, Denmark
- Mr. Amir Delic, Sweden
- Mr. Arnold Kervon, Singapore
- Mr. Juha P Sarlio, Finland
- Mr. Rick Janov, United States
- Mr. Ian Blair, United Kingdom
- Mr. Michael Bennett, United Kingdom
- Mr. Michael Kleinsteuber, United Kingdom
- Mr. Peter Francis, Australia
- Mr. Baris Ozbayraktar, Turkey
- Mr. Terry Chadban, Australia
- Mr. Gareth Blears, United Kingdom

Resources, services, and products of the following organizations have made it possible to develop, deploy, and successfully operate Odds Wizard software:
Odds Wizard Guide

- Borland Software Corporation  USA
- Global Sports Media  Netherlands  (www.soccerway.com)
- Professional Hockey Server  USA
- Microsoft Corporation  USA
- Intel Corporation  USA
- MindVision Software  USA
- FlashScore.com  Czech Republic  (www.flashscore.com)

and many others.
Index

- 3 -
  3D balls space  33

- A -
  Acknowledgements  47

- C -
  Charts of ratings  7
  Computing odds  9
  Current league options  15

- D -
  Data retriever  28
  Depreciation period  15
  Diacritic characters  22

- E -
  Exporting odds to Excel file  9

- F -
  Feeding odds to Stake Wizard  12

- G -
  Games filter  29
  Games table  4
  General overview  3
  Groups and rules of ranking  17

- H -
  Home advantage  15

- I -
  If you are a bookie  14
  Input of league data  8
  Installation notes  47
  Internet options  19

- L -
  Live results and odds  13

- M -
  Main form  4
  Miscellaneous options  22

- O -
  Odds converter  22
  Odds table  4
  Options  14

- P -
  P-Diagram  40
  Performance analysis  30
  Printing odds  9
  Proxy server  19

- R -
  Registration of Odds Wizard  46
  Rename many teams  14
  Rename utility  32

- S -
  Stake Wizard - Betting reports  38
  Stake Wizard - Data input  36
  Stake Wizard - Mathematical background  40
  Stake Wizard - Overview  34
  Stake Wizard - Results of computations  37
  Stake Wizard - Running computations  37
  Stake Wizard - User interface  34